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Welcome to QBI





 

Use of this online manual:

 

•To view topics, click on the chapter headings to expand
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•This online manual provides information on configuring and setting up the optional AyaNova QBI program and use of QBI features. Screenshots depicted in this manual may not display exactly as your copy of QBI, AyaNova and QuickBooks will be different.
 

•Familiarize yourself with the AyaNova program before using QBI - refer to the AyaNova Help file for details.
 

•It is suggested to start off with:
1.The Overview of QBI Features and the Overview of QBI Use and review the QuickBooks Inventory vs AyaNova Inventory section
2.Then proceed to QBI Installation and setup of preferences
3.Note the Common Issues & Messages section if you encounter an issue
4.Review the section on linking, on importing QuickBooks data (customers, vendors, items) into AyaNova, and importing AyaNova data (clients, vendors, parts, rates) into QuickBooks. 
5.Review the section on updating existing linked QuickBooks and AyaNova clients and parts.
6.Review the section on the Descriptive Text feature to have text from the workorder display in the QuickBooks invoice
7.Refer to the Invoicing section for what and how data from the AyaNova workorder is transferred to a QuickBooks invoice.
 

 

 

 

 

 

 





Overview of QBI Features





 

AyaNova QBI has the following features:

 

•Import clients, vendors and items from the QuickBooks company data file into the AyaNova database
•Import clients, vendors, parts and rates from the AyaNova database into the QuickBooks company data file
•Link existing AyaNova data with existing QuickBooks data
•Update existing linked parts information between AyaNova and QuickBooks
•Update existing linked client's information between AyaNova and QuickBooks
•Set linked parts pricing between the AyaNova database and the QuickBooks company data file during the invoicing act
•Export data from AyaNova service workorders into QuickBooks invoices
•Consolidate multiple AyaNova service workorders into one QuickBooks invoice
•Compatible with 64bit computers
 

 

•Import clients, vendors and items from the QuickBooks company data file into the AyaNova database
This way data is only entered once and ensures that the AyaNova items match the QuickBooks items to facilitate converting AyaNova work orders into QuickBooks invoices automatically.

 

•Import clients, vendors, parts and rates from the AyaNova database into the QuickBooks company data file
An example is a new client requests service. Their client information is entered into AyaNova. When it comes time to invoice in QuickBooks, you can just import that AyaNova client's information into QuickBooks without the need to manually re-enter again in QuickBooks.

 

In addition to being able to import AyaNova's clients, parts, vendors and rates into QuickBooks so no re-entry, you can also pre-select the Terms for an AyaNova client imported into QuickBooks

 

•Link existing AyaNova data with QuickBooks data
If you already have the same clients, vendors and/or items entered in both AyaNova and QuickBooks, just link the existing data.

 

Linking is different from importing in that the original AyaNova record is preserved as-is and is marked internally with the record in QuickBooks that it matches to.

 

This is also useful when you have records in AyaNova that differ from QuickBooks.  For example, you may have multiple clients in AyaNova that represent separate locations for service but want to link them all to a single QuickBooks client for billing.

 

This is also useful if you have many pre-existing items in AyaNova as you can link them to QuickBooks records without losing their historical data as you would if you started with newly imported items.

 

If you have already entered in items (clients, parts, rates) into AyaNova, if they have the exact same name as in QuickBooks, they can be auto-linked instead of having to be manually individually re-linked.

 

Previous AyaNova CE 1.9.4.4 users that have updated to the latest AyaNova can auto-link existing AyaNova data with existing data in QuickBooks

 

Older version AyaNova 3 or 4 or 5 users that have updated to the latest AyaNova will have a seamless upgrade as existing links will be maintained.

 

•Update existing linked parts information between AyaNova and QuickBooks
If you make a change to a part in AyaNova, just use the Refresh menu option to update the information into the linked QuickBooks part.

Or vice versa, if you have made a change in QuickBooks, use the Refresh menu option to update the information to the linked AyaNova part.

 

•Update existing linked client's information between AyaNova and QuickBooks
If you make a change to a client in AyaNova, just use the Refresh menu option to update the information into the linked QuickBooks client.

Or vice versa, if you have made a change in QuickBooks, use the Refresh menu option to update the information to the linked AyaNova client.

 

Set linked parts pricing between the AyaNova database and the QuickBooks company data file during the invoicing act

At the time of invoicing, if there is a difference between the AyaNova price and the QuickBooks price, you can select to use the AyaNova price or use the QuickBooks price, as well as have QBI set either the AyaNova workorder price to the QuickBooks price, or set the QuickBooks item price to that of the AyaNova workorder part price. 

 

Export data from AyaNova service workorders into QuickBooks invoices

AyaNova QBI can be used to quickly and easily turn AyaNova work orders into QuickBooks invoices.  All billable items in an AyaNova work order can be exported into an invoice in QuickBooks.  This saves re-entering data manually because the data in the service workorder is directly converted to a QuickBooks invoice without any retyping of information.

 

AyaNova QBI work order export into QuickBooks invoice has the following features:

 

▪Auto select work orders for billing based on AyaNova status.
▪Price protection for parts: AyaNova QBI flags part prices that differ in AyaNova from QuickBooks. You can accept the difference, or change the AyaNova service workorder, or change the AyaNova item price, or change the QuickBooks price to match the AyaNova service workorder - with a click.
▪Automatically ensures that work orders contain only items that are recognized by QuickBooks. If an item has not yet been linked to QuickBooks you can link it quickly and easily.
▪Set descriptive text to include on invoice for the work order – such as work order number, Quick Description field from work order, unit (client equipment) selected within work order, labor details, etc
▪Automatically set the QuickBooks "Class" on invoices via QBI Preferences. If you use Classes in QuickBooks you can select one of the existing QuickBooks classes as a default for all invoices created through AyaNova QBI.
▪Via the QBI Preferences, select the QuickBooks template invoice you wished used if applicable (depends on the version of QuickBooks if available)
▪Choice of invoicing out per service workorder, or consolidate service workorder billable information into one invoice for the same client
▪Set invoices created by AyaNova QBI to "Ready to print" status in QuickBooks via Preferences. This means that you can print all the invoices at once from QuickBooks.
▪All data sent to QuickBooks in the process of creating invoices is automatically verified by QuickBooks for validity. Unlike older .iif file import / export methods of getting data into QuickBooks, AyaNova QBI uses the much more robust software developer interface provided by Intuit for use with QuickBooks. 
Consolidate multiple AyaNova service workorders into one QuickBooks invoice

Easily  consolidate billable service workorders for the same QuickBooks client, or simply select to invoice out each service workorder individually.

 

 

 





Suggested order for use





We suggest the following order from installation, configuration, initial mapping before using QBI for invoicing AyaNova completed service workorders into QuickBooks invoices.  Of course, you can also do your importing/linking as you go along, this is just a suggestion.

 

 

1.Perform the Installation & Configuration to install and configure QBI for use with your QuickBooks company data file and the AyaNova database.
a.QBI installation
b.Start QBI
c.QBI Preferences setup
 

2.Perform the mapping of existing data between the two databases.
 

a.Clients
i.Link existing clients in both AyaNova and QuickBooks (either manually and/or via Auto-Link)
ii.Import non-linked clients from AyaNova to QuickBooks
iii.Import non-linked clients from QuickBooks to AyaNova 
 

b.Vendors
i.Link existing vendors in both AyaNova and QuickBooks (either manually and/or via Auto-Link)
ii.Import non-linked vendors from AyaNova to QuickBooks
iii.Import non-linked vendors from QuickBooks to AyaNova (based on type of vendor)
1.(please note - if Wholesalers are not yet linked before importing QuickBooks Items into AyaNova, you will not be able to select those parts in AyaNova in purchase orders)
 

c.Service Rates
i.Link existing AyaNova Service Rates with QuickBooks (either manually and/or via Auto-Link)
ii.Import non-linked Service Rates from QuickBooks to AyaNova 
iii.Import non-linked Service Rates from AyaNova to QuickBooks 
 

d.Travel Rates
i.Link existing AyaNova Travel Rates with QuickBooks (either manually and/or via Auto-Link)
ii.Import non-linked Travel Rates from QuickBooks to AyaNova 
iii.Import non-linked Travel Rates from AyaNova to QuickBooks
 

e.Parts
i.Link existing parts in both AyaNova and QuickBooks (either manually and/or via Auto-Link)
ii.Import non-linked parts from QuickBooks to AyaNova
iii.Import non-linked parts from AyaNova to QuickBooks
 

3.Edit descriptive text to use on QuickBooks invoices
 

a.If you do print out from AyaNova a detailed completed report for each workorder to accompany the invoice, the descriptive text you use in the invoice could just be the workorder number(s) on the invoice
b.If you do not print out from AyaNova a detailed completed report for each workorder to accompany the invoice, you might have descriptive textinclude aspects of the data from the workorder(s) to display right on the invoice - such as workorder number(s),  schedulable user(s) that performed the service, start and stop Labor times, workorder item summaries, details from each Labor item
 

4.Use QBI to invoice AyaNova service workorders into QuickBooks
 

a.Fix unlinked data (client or parts etc) or price differences between linked AyaNova and QuickBooks parts
b.Invoice single or multiple service workorders via QBI into QuickBooks.
c.Confirm in QuickBooks that the service workorder information was invoiced out correctly.
d.Confirm in AyaNova that the invoice number for the corresponding service workorder(s) was entered in Invoice #: field, service workorder set to closed, status set to that entered in preferences - and if set to fix differing information.
 

 

5.Take advantage of the new feature to refresh parts information and clients information
 

a.Update mapped/linked parts between AyaNova and QuickBooks using the Refresh QuickBooks record or the Refresh AyaNova record menu option in the parts grid or the part's entry screen
b.Update mapped/linked clients between AyaNova and QuickBooks using the Refresh QuickBooks record or the Refresh AyaNova record menu option in the clients grid or the clients entry screen
 

NOTE: QBI only obtains QuickBooks and AyaNova information when QBI first loads

If you enter new information into either QuickBooks or AyaNova with QBI running, you need to refresh the connections in 4 possible ways:

 

1. Select to Refresh QuickBooks connection from the main AyaNova window

[image: RefreshQBIconnection]

2. From within QBI, select Refresh QuickBooks connection

[image: RefreshQBconnection]

3. If not seeing AyaNova service workorders that are ready for invoicing, from QBI's Invoices menu select Refresh invoices

[image: RefreshInvoices]

4. Exit out of QBI, exit out of AyaNova. Log back into AyaNova and start QBI again.

 

 

   

 





QuickBooks Inventory VS AyaNova Inventory





 

A common question asked by service companies using AyaNova along with the optional add-on QBI is "Do I use AyaNova inventory features, or QuickBook's or a combination of both?". The answer to that depends on what you want to do.

 

Benefits of using AyaNova's inventory features along with your QuickBooks

If DO NOT want to use AyaNova's Purchase Orders and its inventory benefits, do the following:

If WANT TO use AyaNova's Purchase Orders and its other inventory benefits, do the following:

If want to use combination of both, do the following:

 

 

Benefits of using AyaNova's inventory features along with your QuickBooks

 

 

AyaNova inventory includes a number of unique features:

 

Part Requests

•With AyaNova Part Request feature, a user can request a part (and quantity and for a specific warehouse) from the AyaNova service workorder. 
•The Part Request is "tied" to that specific service workorder
•Purchasing can easily include in an AyaNova Purchase Order the parts requested to be ordered tied to the specific service workorder
•And when the part is received in AyaNova, if subscribed to the notification "Workorder item part request – parts received", the user logged in who requested the part will be notified the part has been received; and the scheduled user in that service workorder will be notified that the part has been received so that the service can be provided.
 

Part Inventory

•Quantity on-hand in AyaNova is based on what has been entered into inventory via AyaNova Part Adjustments, entered into inventory via AyaNova Purchase Order Receipts. And quantity on-hand is immediately updated whenever anyone indicates the part quantity set in a AyaNova service workorder has been Used In Service.
•This way you can always see at a glance via the Part Inventory grid what warehouses (if used in AyaNova) have what quantity of what parts on-hand
 

Serialization

•You can track serial numbers for Parts in AyaNova
•When receiving parts into inventory via an AyaNova Purchase Order Receipt or entering inventory in via an AyaNova Part Adjustment, if the part has been set as serialized, you can enter serial numbers for the received parts
•And in the AyaNova service workorder, when you select a serialized part, AyaNova will automatically identify this setting the part quantity to 1 and opening the Serial Number field so that you can drop down and select from the list of available serial numbers for this part in inventory.
 

 

Whereas with QuickBooks inventory:

 

•AyaNova is not an accounting program and does not include Accounts Payable. AyaNova does not remind you how much you owe to your vendors, nor when to pay them.
•QBI does NOT have the ability to import AyaNova Purchase Order nor AyaNova Purchase Order Receipt into QuickBooks. These if required, must be manually entered in your QuickBooks.
•When QuickBooks inventory items are sold in an invoice generated by using your QBI to bill out your AyaNova service workorders, your QuickBooks inventory on hand amounts will be updated too.
 

 

 

If DO NOT want to use AyaNova's Purchase Orders and its inventory benefits, do the following:

 

If you want to use QuickBooks inventory only, so that when receiving it updates your Accounts Payable to your vendors

 

1.Confirm that your AyaNova's Use Inventory is set to False in its Global Settings
a.Refer to your AyaNova Help documentation "Global Settings" section for how to.
b.Disabling inventory in AyaNova will disable the ability to create AyaNova POs, PO receipts, tracking serial numbers etc. It will not affect your QuickBooks abilities to do so.
c.Don't worry, disabling inventory in AyaNova will still allow you to identify parts sold to customers in your AyaNova service workorders
2.Complete your QBI installation, QBI preferences, QBI Mapping & Importing and your QBI Descriptive Text setup.
3.Use QuickBooks only for entering PO's and for receiving inventory
a.This way you have only one program that you are entering such data
4.NOTE: Don't worry, when QuickBooks inventory items are sold in an invoice generated by using your QBI to bill out your AyaNova service workorders, your QuickBooks inventory on hand amounts will be updated too!
a.In an AyaNova workorder, you select a part and enter its quantity.
b.If a part is serialized, just enter the serial number in the Description field in the Part record in the AyaNova service workorder
c.Any text entered in the Part Description field will display in the QuickBooks invoice
 

 

If WANT TO use AyaNova's Purchase Orders and its inventory benefits, do the following:

 

1.Confirm that your AyaNova's Use Inventory is set to True in its Global Settings.
a.Refer to your AyaNova Help documentation "Global Settings" section for how to.
2.Complete your QBI installation, QBI preferences, QBI Mapping & Importing and your QBI Descriptive Text setup.
a.Refer to your AyaNova Help documentation for steps on how to enter opening inventory counts in your AyaNova 
3.Use AyaNova for creating Purchase Orders and for receiving
a.Take advantage of AyaNova features such as Part Requests in service workorders to order parts for specific workorders
b.Take advantage of AyaNova inventory serial numbers entry and selection in workorders
4.For your QuickBooks Accounts Payable, you may want to enter total amounts manually into QuickBooks for what you owe vendors that you have  purchased for resale
5.NOTE: Don't worry, when QuickBooks inventory items are sold in an invoice generated by using your QBI to bill out your AyaNova service workorders, your QuickBooks inventory on hand amounts will be updated too!
 

 

If want to use combination of both, do the following:

 

 

1.Confirm that your AyaNova's Use Inventory is set to True in its Global Settings.
a.Refer to your AyaNova Help documentation "Global Settings" section for how to.
2.Complete your QBI installation, QBI preferences, QBI Mapping & Importing and your QBI Descriptive Text setup.
a.Refer to your AyaNova Help documentation for steps on how to enter opening inventory counts in your AyaNova 
3.Use AyaNova for creating Purchase Orders and for receiving, AND REPEAT the POs and the receiving in your QuickBooks.
4.NOTE: Don't worry, when QuickBooks inventory items are sold in an invoice generated by using your QBI to bill out your AyaNova service workorders, your QuickBooks inventory on hand amounts will be updated too!
 

 

 





Common Issues & Messages





 

QBI is not listed as an option in the Plugins menu

Error messages when loading QBI program

Issues importing or linking

Issues invoicing

 

 


Issue: QBI is not displaying as an option in the Plugins menu

[image: QBIRun1]

 

 

This may occur due to two possible reasons:

 

1. You have not completed successfully the QBI installation

 

2. And/or your AyaNova database is not licensed for the optional add-on QBI

 

a. Select main menu Help -> License to view what your present licensing is

 

•If the Registered To: shows "unregistered trial",  then just further down in your license information also check to see if QBI is listed as one of the licensed plugins. If not listed, contact us with your present information and request a temporary key to fully try out QBI
 

•If your Registered To: shows your company name, then just further down in your license information also check to see if QBI is listed as one of the licensed plugins. If not listed, contact us with your present information and request a temporary key to fully try out QBI
 

 

b. Purchase the optional add-on QBI license from https://www.ayanova.com/purchase.htm 

 

[image: QBIlicense]

     

 

 

 


Issue: Receive a message with error code (HRESULT:0x80040418) when you run QBI for the first time.

 

Solution:

Usually this means that you need to be logged into your QuickBooks data file as the admin.

The first time QBI loads, QBI needs to be granted permission to access the QuickBooks company data file

Run QuickBooks again, this time logging in as admin. Then run QBI

 

 

 

Issue: Receive similar message to:

 

Could not load file or assembly 'Interop.QBFC7

 

Solution:

This usually means that you have not installed the QBFC7 that is required as per step 1.d of the installation steps

Redo your steps making sure you have installed the QBFC7

 

 

Issue: Receive similar message to 

 

Retrieving the COM class factory for component with CLSID {FC3C4882-C13E-46E7-96F1-CEE3133207B7} failed due to the following error: 80040154  and you are running QBI on a 64 bit computer

 

Solution:

Make sure you are running the latest version of AyaNova 6.6 and higher which IS compatible with 64bit computers.

 

 

Issue: This similar message to 

 

Could not start QuickBooks. Error code:(HRESULT:0x80040408) 

[image: QBIerrorasQBnotrunning]

 

Solution:

Run QuickBooks and ensure the correct QuickBooks company data file is opened

Now run QBI again.

 

 

 

Issue: As the message states, your company QuickBooks data file must be running on this computer

[image: 2QBnotrunning]

 

Solution:

Run QuickBooks and ensure the correct QuickBooks company data file is opened

Select Retry, or if had canceled, run QBI again.

 

 

Issue: As the message states, one or more workorders do not have a labor rate (or the message could refer to a Travel rate) selected.

[image: nolaborrateselected]

 

Solution: 

Select Quit, open AyaNova and select the rate indicated in the error message for that workorder.

 

 

 


Issue: You are trying to link existing items, but every time you select a item, it pops up information about the item instead of letting you select and drag it to the item you want to link to

 

Solution:

You need to select the object indicator (square to the left of the item) and drag that. Refer again to the screenshots and steps provided in the link or import section.

[image: clickandhold]

 

[image: dragovertop]

 

 

Issue: You are trying to import existing items, but every time you select a item, it pops up information about the item instead of letting you select and drag it to drop to import

 

Solution:

Same as with the issue above, be sure to select the object indicator (square to the left of the item) and drag that.

 

 

 

Issue: You have imported QuickBooks items as AyaNova parts, but now you can not select these parts in an AyaNova purchase order.

 

Cause:

You DID NOT have the vendor imported into AyaNova before you imported the QuickBooks parts into AyaNova - as a result there is no vendor selected in the newly imported AyaNova parts

 

Solution:

You will need to manually edit each AyaNova part that was imported, and select a vendor in that AyaNova part's entry screen.

 

 

 

 


Issue: No service workorders display as ready for invoicing even though you are sure there are

[image: Noinvoiceableworkorders]

 

Solution:

Please refer to the section in this documentation titled No service workorders ready for invoicing as if you do have workorders ready for invoicing, one of the required four settings are not applied to the workorder(s)

 

 

 

Issue: You select Invoice Selected Items to QuickBooks, but the service workorders continue to display in the QBI list, and the invoices are not created in QuickBooks.

 

Solution: 

You have not selected what you actually want to invoice. 

QBI allows you to select individual or multiple service workorders at one time. Use your mouse to click on the object indicator (square to the left of the client name or to the left of the row depicting the service workorder number) and than either right-click and select Selected Items to QuickBooks, or select the menu Invoices -> Selected Items to QuickBooks.

And you can also hold down the CTRL keyboard key, and select multiple service workorders / client names to invoice all ready to invoice service workorders.

 

 

 

Issue: The Rate set in QuickBooks for a Outside Service charge, or a Misc Expense charge or a Travel charge, or a Service charge is not what shows in the QuickBooks item Rate field - but instead is from what shows is the AyaNova retail charge for that item

 

Solution:

This is correct and is the way QBI tells QuickBooks what to charge for these items.

Please refer to the sections under Invoicing regarding these items.

 

 

Issue: You've edited service workorders, or edited AyaNova or QuickBooks objects, but QBI does not display these changes

 

Solution:

QBI only obtains QuickBooks and AyaNova information when QBI first loads - so if you enter new information into either QuickBooks or AyaNova with QBI running - QBI will not be aware of it until you refresh the QuickBooks connection from the main Plugins menu, or exit completely out of AyaNova and then log back in and restart QBI. 
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Issue: You select to invoice, and receive error message similar to one of the following:

 

PartPickList: ID not found:

 

or 

 

ClientPickList: ID not found:

 

or 

 

RatePickList: ID not found:

 

Solution:

QBI only obtains QuickBooks and AyaNova information when QBI first loads - so if you enter new information into either QuickBooks or AyaNova with QBI already running - QBI will not be aware of it until you refresh the QuickBooks and AyaNova connection from the main Plugins menu; or exit completely out of AyaNova and log back in, and start QBI again. 
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QBI Installation





It is always recommended to read through all instructions first, and than perform the actual steps

 

 

1.Requirements before proceeding
 

Do not proceed until you have answered yes to each of these requirements:

 

 

a.Do you have a compatible QuickBooks program installed and operational on the local hard drive of your computer - with the latest QuickBooks service patches applied?
•U.S. QuickBooks 2007 version on through to the latest 2017 version
•Canadian editions QuickBooks 2008 and newer versions
•UK editions of QuickBooks Pro and Accountant Editions 2008 and newer versions
•newer editions of QuickBooks versions then those listed above are also expected to be compatible with no issues - if you have an issue, check Common Issues & Messages for known resolutions
 

•Australian QuickBooks QBi 2008/2009, 2009/2010, 2010/2011, 2011/2012 and QBi 2012/2013 
 

b.Do you have the latest QuickBooks service patches applied to your QuickBooks?
 

c.Have you confirmed that while in your QuickBooks program, you can successfully open your company data file? 
•the QuickBooks company data file can be located either on the local hard drive too, or it can be located on another networked computer.
 

 

d.Have you downloaded the Intuit QuickBooks required QBFC7_installer.exe from http://www.ayanova.com/download.htm under Other AyaNova Related Downloads ?
And have you installed it successfully? 

 

 

e.Is your AyaNova database licensed for QBI?
•Select main menu Help -> License
 

oIf the Registered To: shows "unregistered trial",  then just further down in your license information also check to see if QBI is listed as one of the licensed plugins. If not listed, contact us with your present information and request a temporary key to fully try out QBI
 

oIf your Registered To: shows your company name, then just further down in your license information also check to see if QBI is listed as one of the licensed plugins. If not listed, contact us with your present information and request a temporary key to fully try out QBI
 

f.Do NOT install QBI to a 64bit computer that also has the network AyaNova Generator nor the ToMSSQL installed. 
oQBI is compatible with 64bit computers - just NOT on a 64bit computer where you also have network Generator and/or ToMSSQL installed.
oQBI only should be installed on workstations that will actually run the QBI optional add-on, NOT onto your server with your networked database.
 

 

 

2.Install AyaNova and QBI via the AyaNova installation file.
 

a.Run the AyaNova installation file AyaNovaSetup.exe, and select QBI where indicated to install to your local hard drive
[image: defaultsetup2]

 

[image: Setup4b]

 

•Refer to the AyaNova installation steps in the AyaNova Help file for installing AyaNova either for single stand-alone use or for networked use if you require additional assistance.
 

•Do note that if you have already installed AyaNova, just run your AyaNovaSetup.exe file again,  selecting the same installation, and select to install QBI. All this does is replace the existing program files previously installed, plus what you additionally select.
 

•Make sure you have AyaNova closed if installing again
 

•When asked if you want to overwrite the config.txt, select No.
 

•NOTE: if you get a message such as below about replacing a file, this is occurring because you have something running. Click Abort, and then check to make sure you do NOT have the AyaNova program running, nor any of the import/export utilities, and check Services to make sure that the AyaNova Generator is shut off while installing, and IIS to shut down the Default Web Site and AyaNovaDP (the data portal) if installed. Then run the installation again.
[image: setuperror_if_dp_or_generatorrunning]

 

b.The QBI program file will be installed to C:\Program Files\Ground Zero Tech-Works Inc\AyaNova\plugins\QBI 
 

 

3.QBI uses the same configuration file as the AyaNova program so no further program installation steps are needed
 

 

 

 





Starting QBI





 

 

1. Confirm installation has been completed.

 

2. Confirm that your QuickBooks program is running with your QuickBooks company data file open.

 

3. Log into AyaNova as a user that has minimum Read/Write/Delete rights in their security group to the following:

•Object.Client
•Object.Part
•Object.Rate
•Object.Vendor
•Object.Workorder
•Object.WorkorderService
 

4. Start the QBI program from within the AyaNova program from the Plug-Ins menu at the very top

 

[image: QBIRun1]

 

 

NOTE: AyaNova QBI requires that the QuickBooks program be loaded and accessing your QuickBooks company data file before QBI is loaded.

So if you receive a message such as below, you need to start your QuickBooks program AND access your company data file. And then you can proceed.

		[image: 2QBnotrunning]


 

 

 

a. NOTE: If this is your first time running QBI with this specific QuickBooks database you presently have open, you DO AND WILL have to switch back to your QuickBooks desktop program to allow access to the QuickBooks company data file. 

 

Regardless of what your version of allowing QuickBooks approval may look like,  always select to always allow full access 

[image: 3bQBauthorization]

 

and your version of QuickBooks may also require have additional confirmation. 

[image: 4bQBauthorization]

 

 

 

b. Once access has been granted (QBI will only require this to be set in your QuickBooks the first time), then objects from your QuickBooks and from your AyaNova will be read for access by QBI

[image: QBIsetup4]

 

 

c. And once loaded, will also get you to confirm this IS the QuickBooks company data file you want to connect to:

[image: QBIsetup5]

 

 

d. If this is your first time running QBI, you will now be led to identify your QBI Preferences

 

[image: QBIsetup6]

 

 

 

e. NOTE: If you are presented with a window stating that one or more of your QBI Preferences previously set needs to be re-selected, click OK and complete the Preferences shown once you click OK

[image: QBIPreferenceschanged]

 

AND ALSO before performing any other QBI actions including mapping/linking, etc again go through all of your QBI Preferences to ensure all required preferences are still correct.

 

The above can occur in the following situations:

•The AyaNova database was previously used at some point with some QuickBooks database
•Preferences previously set are no longer available 
oi.e. the Workorder Status set for when closing a workorder after invoicing is no  longer available
oi.e. the QuickBooks item you linked to for the Preference has been set to inactive or deleted
 

 

 

NOTE: The AyaNova QBI menu option from the client's grid menu or the AyaNova QBI menu option from the Parts grid menu is for specific QBI functions relating only to importing and linking clients and parts once the main QBI interface has connected to your QuickBooks and your AyaNova.

These menu options do not start the main QBI program.

 

•from the client's grid menu
[image: QBIRun2]

 

•from the part's grid menu
[image: QBIRun3]

 





QBI Preferences





 

It is always suggested to read through all instructions first, and than perform the actual steps

 

 

1.Confirm that your AyaNova and QBI installation has been completed.
 

2.Confirm that your QuickBooks program is running with your QuickBooks company data file open.
 

3.Log into AyaNova as a user that has minimum Read/Write/Delete rights in their security group to the following:
•Object.Client
•Object.Part
•Object.Rate
•Object.Vendor
•Object.Workorder
•Object.WorkorderService
 

4.Start the QBI program from within the AyaNova program from the Plug-Ins menu at the very top
[image: QBIRun1]

 

5.If you receive the following message, select OK to close QBI - your database does not have a current subscription to use QBI. 
a.Resolve by purchasing the appropriate subscription license, log into AyaNova as manager, and apply your AyaNova subscription activation key-code that is licensed for QBI, and than return to these steps.
[image: QBIlicenserequired]

 

 

 

6.QBI will now read the data from the QuickBooks company file and from your AyaNova database
[image: QBIsetup4]

		


7.Confirm the path and company name of the QuickBooks company data file. 
a.If the path and database listed is not correct, than select the [image: Cancel1] Cancel button to exit out of QBI
 

b.Then open the correct QuickBooks company data file in the running QuickBooks program on this computer. 
c.If the path and database listed is correct, select the [image: OK1] OK to continue. <note that path stated in screenshot below is only an example>
		[image: QBIsetup5]


 

8.Your QBI Preferences now need to be set up
[image: QBIsetup6]

 

 NOTE: If instead you are presented with a window stating that one or more of your QBI Preferences previously set needs to be re-selected, click OK and complete the Preferences shown once you click OK

[image: QBIPreferenceschanged]

 

AND ALSO before performing any other QBI actions including mapping/linking, etc again go through all of your QBI Preferences to ensure all required preferences are still correct.

 

The above can occur in the following situations:

•The AyaNova database was previously used at some point with some QuickBooks database
•Preferences previously set are no longer available 
oi.e. the Workorder Status set for when closing a workorder after invoicing is no  longer available
oi.e. the QuickBooks item you linked to for the Preference has been set to inactive or deleted
 

 

 

Preferences can also be accessed from Tools -> Preferences and make sure each has something correctly selected before continuing. 

[image: Tools-Preferences]

 

 

 

9. As the information on the window states, set the status of the billable workorder. <note that AyaNova Workorder  Status selected in screenshot below is only an example>

      [image: 7setupstatusbefore]

 

10. As the information on the window states, set the status the workorder will be set to once invoiced. <note that AyaNova Workorder  Status selected in screenshot below is only an example>

		[image: 8setupstatusafterinvoice]


 

11. As the information on the window states, set the QuickBooks item to use when billing Outside Service

		[image: 8outsideservicechargeQBaccount]


 

12. As the information on the window states, select the QuickBooks item to use when invoicing miscellaneous expenses in a service workorder item.

      [image: 10miscQBaccount]

 

13. As the information on the window states, select the QuickBooks item to use when invoicing loan charges in a service workorder item

		[image: 17loancharges]


 

14. As the information on the window states, select the QuickBooks transaction class if used.

		[image: 11QBClasses]


 

 

 

15. As the information on the window states, select the QuickBooks invoice template to use for invoicing service workorders from AyaNova.

[image: 12aQBtemplatesnotsupported]

 

a.If you instead get a screen stating this feature is not supported, as the information on the window states, it is due to the version of your QuickBooks.
		[image: 12QBtemplatesnotsupported]


 

16. As the information in the window states, select the default Terms you want QBI to set the QuickBooks client to when import a client from AyaNova into Quickbooks. 

[image: QBIdefaultterms]

 

17. As the information on the window states, either uncheck or leave check-marked the To Be Printed in a QuickBooks invoice that is created.

		[image: 13QBtobeprinted]


 

18. As the information on the window states, either uncheck or leave check-marked to use the QuickBooks internal memo field

		[image: 14QBmemo]


 

19. As the information in the window states, either check or leave check-marked to have the AyaNova workorder set to the Closed state once the workorder has been invoiced via QBI into QuickBooks. 

 

NOTE: A workorder checked to Closed can not be edited or deleted by anyone - this makes sure that no one bills out customers and then deletes or edits the workorder afterwards. Only the AyaNova Administrator can unClose a workorder. Refer to your AyaNova online Help documentation regarding the Closed field in the service workorder for more information.

 

[image: PreferenceCloseWOafterinvoicing]

 

20. Preferences are now completed

 

21. Select to open QBI 

[image: QBIrun5]

 

 

22. AyaNova QBI will now prompt you to map/link data (i.e. clients, vendors, rates, parts) between your AyaNova database and your QuickBooks database.

 

This could entail link existing items. This could entail importing from one to the other. This could entail a bit of both. 

Refer to this QBI documentation section starting with Mapping & Importing for specifics.

 

 [image: 15nowneedtomapbetween]

 

 

 

NOTE: You can always change these preferences at any time from within QBI by selecting the menu option Tools -> Preferences and going through the wizard selection of preferences again.

 

[image: Tools-Preferences]

 

 

 

 

 





What is Mapping (linking)?





 

Mapping existing data is when you have the object already entered in both AyaNova and QuickBooks, so you wish to link or map the two objects together without actually changing the data in either database.

 

•NOTE: Mapping objects does not update information from one object to the other - it only links the  existing QuickBooks object to the existing AyaNova object. If you want to update the data of one with the data of the other, refer to Update Mapped/Imported Parts and/or Update Mapped/Imported Clients
 

•If the clients are not mapped, QBI will not know which QuickBooks customer is  to be invoiced for the AyaNova service workorder; or which QuickBooks items are to be invoiced out for the AyaNova parts and rates on the service workorder.
 

•If the QuickBooks vendors are not mapped (linked) to AyaNova vendors, imported or linked parts will not have the corresponding linked QuickBooks vendor to the AyaNova wholesaler. 
 

•If the QuickBooks parts are not mapped (linked)  to AyaNova parts, QBI will not know what QuickBooks Item to invoice out for the part on the AyaNova service workorder.
 

•If the QuickBooks rates are not mapped (linked) to AyaNova rates, QBI will not know what QuickBooks Item to invoice out for the rate on the AyaNova service workorder.
 

 

Examples of situations when  you would use the manual  link feature of QBI is:

 

1.Existing clients in AyaNova are actually billed to a head office that is entered in QuickBooks
•So you would want multiple AyaNova clients mapped (linked) linked to one QuickBooks customer (which is the one office that all these AyaNova clients get their invoices sent to).
 

2.You have manually entered some data in AyaNova that may not have the exact same name as the name in QuickBooks
• So the automatic link Auto-Link feature would not work
 

3.You want full control over what existing AyaNova data is linked to what existing data in QuickBooks
• So you want to manually map (link) each QuickBooks object to each AyaNova object




How to manually link existing data





 

To manually link (map) an AyaNova object to a QuickBooks object by selecting and dragging the AyaNova object to the specific QuickBooks object:

 

1.If not already viewing the Map & Import screen select the menu Tools -> Map & Import from the main QBI screen
[image: Tools-MapImport]

 

2.Select what type of object you wish to map & import by selecting the menu Object  <In the following screenshot we have selected to map & import Clients>
[image: mapimportobjectclients]

 

3.Find on the AyaNova side the AyaNova object you want to link, and find on the QuickBooks side the QuickBooks object you want to link. <in this example its the AyaNova client Lawyers R Us and the QuickBooks customer Kim, Glen>
 [image: findtolink]

 

4.Click and hold down on the indicator (the square to the left of the AyaNova object's name) <you will note that the object indicator now shows an arrow within it>
 [image: clickandhold]

 

5.Now drag it to the QuickBooks object and release overtop of the QuickBooks object  <you will note your cursor changes to a [image: cursordrag] while dragging it>
 [image: dragovertop]

 

 

6.QBI will pop up a window to confirm this is the QuickBooks object you wish to link this AyaNova object with
 [image: acceptmanuallink]

 

7. Now the two objects will show the linked symbol

 

[image: link2]

 

 

8. You can also select multiple AyaNova objects at one time by holding down the CTRL key on your keyboard and than select the object indicator of each item, and than dragging all at the same time to the QuickBooks object you want them all to link to.

 

9. You can also select multiple AyaNova object at one time by holding down the SHIFT key on your keyboard, select the first listed object, and the last listed object, and all will be selected so you can than drag all to manually link at the same time to the QuickBooks object. 

 

 

 

NOTE: QBI only obtains QuickBooks and AyaNova information when QBI first loads

If you enter new information into either QuickBooks or AyaNova with QBI running, you need to refresh the connections in 4 possible ways:

 

1. Select to Refresh QuickBooks connection from the main AyaNova window

[image: RefreshQBIconnection]

2. From within QBI, select Refresh QuickBooks connection

[image: RefreshQBconnection]

3. If not seeing AyaNova service workorders that are ready for invoicing, from QBI's Invoices menu select Refresh invoices

[image: RefreshInvoices]

4. Exit out of QBI, exit out of AyaNova. Log back into AyaNova and start QBI again.

 

 

 

 





How to automatically link existing data





 

An example of the situation when  you would use the automatic link (map) feature of QBI is:

 

1.You previously used a really old version QBI v1.2.2.0 with AyaNova CE 1.9.4.4
•But you have now upgraded to the latest AyaNova
•You have imported your AyaNova CE 1.9.4.4 data into the latest AyaNova
•Now you need to link the previously imported and linked AyaNova data to that of your QuickBooks company data file again for use with QBI.
 

2. You have manually entered in clients, parts, rates, vendors with the same name/number into your AyaNova database as that in your QuickBooks

• Automatic linking will compare names of each object and link that which it most believes is correct.
 

 

The automatic link does not update information from one object to the other - it links the two objects only.

 

The automatic link feature compares the QuickBooks object name to that of a corresponding AyaNova object.

 

The automatic link does not compare other fields of information for the object - only the name.

 

 

 

The fields that are compared during Auto-Link

 

The automatic link feature will compare the following field of data between the two objects and than automatically link if they are the same:

 

QuickBooks customer entry        AyaNova client entry

 Company Name                        Client Name

 

QuickBooks vendor entry        AyaNova vendor entry

 Vendor Name                        Vendor Name

 

QuickBooks Item entry                 AyaNova Part entry

 Item Name/Number                Part Number

 

QuickBooks Item entry                AyaNova Rate entry

 Item Name/Number                Rate Name

 

 

 

To automatically link AyaNova objects with QuickBooks objects of the same name is just selecting the Auto Link menu option:

 

1.If not already viewing the Map & Import screen select the menu Tools -> Map & Import from the QBI main screen
[image: Tools-MapImport]

 

2.Select what type of object you wish to map & import by selecting the menu Object  <In the following screenshot we have selected to map & import Clients>
[image: mapimportobjectclients]

 

3. Select the menu option Auto Link

     [image: autolink]

 

4. AyaNova objects now linked will display the link symbol [image: link1]

 

 

NOTE: QBI only obtains QuickBooks and AyaNova information when QBI first loads - so if you enter new information into either QuickBooks with QBI running - QBI will not be aware of it unless you refresh the connections.

 

1. Select to Refresh QuickBooks connection from the main AyaNova window

[image: RefreshQBIconnection]

2. From within QBI, select Refresh QuickBooks connection

[image: RefreshQBconnection]

3. If not seeing AyaNova service workorders that are ready for invoicing, from QBI's Invoices menu select Refresh invoices

[image: RefreshInvoices]

4. Exit out of QBI, exit out of AyaNova. Log back into AyaNova and start QBI again.

 

 





How to unlink (unmap)





Unlink (unmap) either via the linked AyaNova object or via the linked QuickBooks object.

 

•It is not possible to unlink (unmap) multiple objects at once. Each object must be unlinked manually. 
 

 

Unlink by the linked AyaNova object:

 

Unlink by selecting the linked AyaNova object to display the information on the QuickBooks object linked to, and select the Unlink button.

 

[image: linked0]

 

[image: linked1]

 

[image: linked2]

 

[image: linked3]

 

[image: linked4]

 

 

 

 

Unlink by the linked QuickBooks object:

 

Unlink by selecting the linked QuickBooks object to display the information on the AyaNova object linked to, and select to uncheck the linked AyaNova object.

 

[image: linked1a]

 

[image: linked2a]

 

[image: linked3a]

 

[image: linked4a]

 

[image: linked5a]

 

[image: linked6a]

 





If delete or remove linked items in QuickBooks





Every time once you run QBI or refresh QBI, QBI will run a pre-flight check to obtain a cache of QuickBooks data, AyaNova data, to see if you have configured your preferences, and will compare existing linked QuickBooks objects with AyaNova objects.

 

QBI will prompt each unlinked or missing QuickBooks object one by one, identifying if the item's "item name" is missing or set to Inactive in QuickBooks and confirming if you want to remove the link. QBI will prompt yes no cancel.

 

[image: inactivenonlinked]

 

If you select Yes the item will be unlinked.

If you select No QBI will go on to the next mismatch in the list if any. 

If you select Cancel QBI will abort the startup and shut down itself. 

 

Do note that if you delete or set to inactive something in QuickBooks after you have already successfully logged into QBI, as QBI will already have its populated  cache of QuickBooks items - QBI will not know that you have since deleted or set to inactive until you have refreshed the connection again.

 

1. Select to Refresh QuickBooks connection from the main menu

[image: RefreshQBIconnection]

2. From within QBI, select Refresh QuickBooks connection

[image: RefreshQBconnection]

3. If not seeing AyaNova service workorders that are ready for invoicing, from QBI's Invoices menu select Refresh invoices

[image: RefreshInvoices]

4. Exit out of QBI, exit out of AyaNova. Log back into AyaNova and start QBI again.

 

 

 





How to import QuickBooks data into AyaNova





 

This section will overview the easy steps to import QuickBooks data (whether it be customers, vendors or items) into AyaNova.

 

•If you have just finished configuring QBI for the first time, after the following message QBI will open to the Map/Import screen defaulting to displaying the AyaNova client objects on the left and the QuickBooks customers on the right
[image: 15nowneedtomapbetween]

 

•Or if you need to import objects at any time, select the menu Tools, than Map and import to open the Map/Import screen which defaults to showing the AyaNova clients on the left and QuickBooks customers on the right. 
[image: Tools-MapImport]

 

•Select the menu Object to drop down to select which objects (clients, parts, vendors, rates) you want to import.
[image: objects-vendors-wholesalers]

 

 

 

Basic steps to import

 

1.Click and hold down on object indicator (the square to the left of the QuickBooks item (customer, vendor or item))  <you will note that the object indicator now shows an arrow within it>
[image: dragqbtoaya1]

2.Now drag it to the Drop here to import QuickBooks item(s) <you will note that your cursor changes to a [image: cursordrag] while being dragged>
[image: dragqbtoaya2]

3.Release over the Drop here to import QuickBooks item(s) and confirmation that you want to import will display.
[image: dragqbtoaya3]

4.You can also import multiple QuickBooks items at one time by select the first QuickBooks item and than holding the SHIFT key when you select the last QuickBooks item – which highlights all those listed. And than drag and drop as above.
[image: dragqbtoaya4]

5.Or select the first QuickBooks item, hold the CTRL key and individually select more QuickBooks items <note how only the items selected are highlighted>. And than drag and drop as above.
[image: dragqbtoaya5]

 

The same steps applies to importing QuickBooks Vendors as AyaNova vendors, QuickBooks items as AyaNova parts, and importing QuickBooks items (service) as AyaNova rates - you drag and drop which items you want to import into the Drop  here to import QuickBooks item(s) location.

 

 

NOTE: QBI only obtains QuickBooks and AyaNova information when QBI first loads

If you enter new information into either QuickBooks or AyaNova with QBI running, you need to refresh the connections in 4 possible ways:

 

1. Select to Refresh QuickBooks connection from the main menu

[image: RefreshQBIconnection]

2. From within QBI, select Refresh QuickBooks connection

[image: RefreshQBconnection]

3. If not seeing AyaNova service workorders that are ready for invoicing, from QBI's Invoices menu select Refresh invoices

[image: RefreshInvoices]

4. Exit out of QBI, exit out of AyaNova. Log back into AyaNova and start QBI again.

 

 

 





QuickBooks customers data that is imported into AyaNova





The following identifies the information that is imported into the AyaNova client from a QuickBooks customer :

 

If the information is not listed here, it does not get imported from the AyaNova client via QBI into a QuickBooks customer.

 

Note the following:

 

•As QBI can not identify if the first line of what is in the Address field (#7 below) has the client's company name in it or not - therefore all lines from the Address field in a QuickBooks client company record is imported into the Street field of an AyaNova client record.
•QuickBooks Tax Codes are not importable into AyaNova.  An invoice in QuickBooks created by QBI uses the tax codes set up for the QuickBooks object (i.e. client) - QBI does not transfer or do anything with the tax code selected in the AyaNova service workorder.
 

 

The fields of data that are imported from a QuickBooks Customer object to an AyaNova Client object are:

 

 QuickBooks customer                AyaNova client

 

1        Company Name                        Client Name                                

2        Contact                                Contact

3        Phone                                        Business

4        Fax                                        Fax

5        Alt. Ph                                Home

6.        Email                                        Email

7.        Bill To                                        Postal Address

8.        Ship To                                Physical Address

 

9.        Account No.                                Account Number

 

11        Address                                Street

12        City                                        City

13        Province/State                        State or Province

14        Postal Code / Zip                        Postal / Zip Code

15        Country / Region                        Country

 

 

 

QuickBooks client fields identified:

 

[image: ClientQBtoAya1]

 

[image: ClientQBtoAya6]

 

[image: ClientQBtoAya5]

 

 

AyaNova client fields identified:

 

[image: ClientQBtoAya2]

 

 

[image: ClientQBtoAya3]

 

[image: ClientQBtoAya4]





QuickBooks vendors data imported into AyaNova





The following identifies the information that is imported into the AyaNova vendor from a QuickBooks vendor :

 

If the information is not listed here, than it does not get imported.

 

 

NOTE the following:

 

•The AyaNova vendor type set in the imported vendor entry screen is dependant on the QBI object vendor type selected before importing
 

For example, if as per the screenshot below, you select Wholesaler, than any QuickBooks vendors imported would be set as the AyaNova type Wholesaler.

 

[image: objects-vendors-wholesalers]

 

As an AyaNova vendor is one of five set types, whereas QuickBooks you can create as many types as you wish - the AyaNova vendor types is not set by the type as set in QuickBooks - only set by the QBI object  vendor type selected before importing.

 

•The QuickBooks vendor address is imported into both the Physical and the Postal Address of the AyaNova vendor.
 

 

 

The fields of data that are imported from a QuickBooks Vendor object to an AyaNova Vendor object are:

 

 QuickBooks vendor                AyaNova vendor

 

1        Vendor Name                        Vendor Name

2        Contact                                Contact

3        Phone                                        Business

4        Fax                                        Fax

5        Alt. Phone                                Home

6        Email                                        Email

7        Address                                Postal and Physical Address

 

8        Account No.                                Account Number

 

*You will note that as there are many ways of entering in a telephone area code, that QBI is not able to distinguish what is the phone number and what is an area code from the QuickBooks entry - so all numbers are entered into the Phone column in the AyaNova client contact.

 

QuickBooks vendor fields identified:

 

[image: VendorQBtoAya1]

 

[image: VendorQBtoAya2]

 

 

AyaNova vendor fields identified:

 

[image: VendorQBtoAya3]

 

 





QuickBooks Items (Inventory or Non-inventory) data imported into AyaNova





The following identifies the information that is imported into the AyaNova part from a QuickBooks item :

 

If the information is not listed here, than it does not get imported.

 

NOTE the following:

 

•Only if the preferred QuickBooks vendor is linked with an AyaNova vendor that is of type Wholesaler. Before importing QuickBooks items into AyaNova, make sure you have already imported or linked AyaNova Vendors that are set as type Wholesaler and QuickBooks vendors - otherwise the part will not have an associated vendor and not be able to be selected in purchase orders without additional editing in AyaNova***
 

 

The fields of data that are imported from a QuickBooks Item (of type Inventory or Non-inventory) object to an AyaNova Part object are:

 

 

 QuickBooks Item                                AyaNova part

 

1        Item Name/Number                                Part Number

2        Description on Sales Transactions                Part Name

3        Sales Price                                        Retail Charge

4        Cost                                                Cost

5        Preferred Vendor                                Wholesaler***

 

 

 

 

Example 1:

 

QuickBooks Item (inventory) fields identified:

 

[image: qbpartintoaya1]

 

AyaNova Part fields identified:

 

[image: qbpartintoaya2]

 

Example 2:

 

QuickBooks Item (inventory) fields identified:

 

[image: qbpartintoaya3]

 

AyaNova part fields identified:

 

[image: qbpartintoaya4]

 





QuickBooks Items (Service or Other Charge) data imported into AyaNova





The following identifies the information that is imported into the AyaNova rate from a QuickBooks item :

 

If the information is not listed here, than it does not get imported.

 

 

 

The fields of data that are imported from a QuickBooks Item (of type Service or Other Charge) object to an AyaNova Rate object are:

 

 QuickBooks Item                                AyaNova rate

 

1        Item Name/Number                                Rate Name

2        Description                                        Description

3        Sales Price                                        Retail Charge

4                                                        Rate Type*

 

 

*Whether a QuickBooks Item (of type Service or Other Charge) is imported as a Service type or a Travel type is dependant on that you selected Travel rate or Service rate in QBI

[image: selecttravelorservice]

 

 

 

QuickBooks Item (service or non-inventory) fields identified:

 

[image: qbserviceintoaya1]

 

AyaNova Rate fields identified:

 

[image: qbserviceintoaya2]

 

 

 

 





How to import AyaNova data into QuickBooks via Map and Import





 

This section will overview the easy steps to import QuickBooks data (whether it be customers, vendors or items) into AyaNova.

 

•If you have just finished configuring QBI for the first time, after the following message QBI will open to the Map/Import screen defaulting to the Clients objects.
[image: 15nowneedtomapbetween]

 

•Or if you need to import objects at any time, select the menu Tools, than Map and import to open the Map/Import screen which defaults to showing the AyaNova clients on the left and QuickBooks customers on the right. 
[image: Tools-MapImport]

 

•Select the menu Object to drop down to select which objects you want to import 
[image: objects-vendors-wholesalers]

 

 

 

 

Basic steps to import

 

1.Click and hold down on the object indicator (the square to the left of the AyaNova client or vendor)  <you will note that the object indicator now shows an arrow within it>
[image: dragayanovatoqbimport1]

2.Now drag it to the Drop here to import AyaNova item(s) <you will note that your cursor changes to a [image: cursordrag] while being dragged>
[image: dragayanovatoqbimport2]

3.Release over the Drop here to import AyaNova item(s) and confirmation that you want to import will display.
[image: dragayanovatoqbimport3]

4.You can also import multiple AyaNova items at one time by select the first AyaNova client or vendor and than holding the SHIFT key when you select the last AyaNova client or vendor <note how all from the first selected to the last are highlighted>. And than drag and drop as above.
[image: dragayanovatoqbimport5]

5.Or select the first AyaNova item, hold the CTRL key and select more AyaNova items <note how only the items selected are highlighted>. And than drag and drop as above.
[image: dragayanovatoqbimport4]

 

 

NOTE: QBI only obtains QuickBooks and AyaNova information when QBI first loads

If you enter new information into either QuickBooks or AyaNova with QBI running, you need to refresh the connections in 4 possible ways:

 

1. Select to Refresh QuickBooks connection from the main menu

[image: RefreshQBIconnection]

2. From within QBI, select Refresh QuickBooks connection

[image: RefreshQBconnection]

3. If not seeing AyaNova service workorders that are ready for invoicing, from QBI's Invoices menu select Refresh invoices

[image: RefreshInvoices]

4. Exit out of QBI, exit out of AyaNova. Log back into AyaNova and start QBI again.

 

 

 





How to import AyaNova clients or parts into QuickBooks via AyaNova grid or entry screen





 

AyaNova Clients can be imported into QuickBooks using the QBI quick menu options in the AyaNova Clients grid menu, and/or the Client's entry screen menu 

 

AyaNova Parts can be imported into QuickBooks using the QBI quick menu options in the AyaNova Parts grid menu, and the Part's entry screen menu 

 

 

Below is an example of importing an AyaNova part into QuickBooks from the AyaNova Part grid; and after that is an example of importing an AyaNova client into QuickBooks from the AyaNova Client entry screen

 

Example - importing an AyaNova part into QuickBooks from the AyaNova Part grid:

 

1. Select the part record you want to import. Note how you can tell it is selected as in addition to the row being highlighted, also all fields are underlined.

[image: AyaParttoQBgrid1]

 

2. Select the PlugIns menu option in the Parts grid menu and select AyaNova QBI -> Export unlinked items to QuickBooks

[image: AyaParttoQBgrid2]

 

[image: AyaParttoQBgrid3]

 

3. Select Yes to export

[image: AyaParttoQBgrid4]

 

4. Select the QuickBooks COGS Account, Income Account and Asset Account for this part

[image: AyaParttoQBgrid5]

 

5. The part will be imported into QuickBooks

[image: AyaParttoQBgrid6]

 

 

 

 

 

Example - importing an AyaNova client into QuickBooks from the AyaNova Client entry screen:

 

1. In the Client entry screen, select the Plugins menu option selecting AyaNova QBI -> Export to QuickBooks

[image: AyaClienttoQBentry1]

 

[image: AyaClienttoQBentry2]

 

2. Click Yes to export

[image: AyaClienttoQBentry3]

3. The client will be imported into QuickBooks

[image: AyaClienttoQBentry4]

[image: AyaClienttoQBentry5]

 





AyaNova clients data imported into QuickBooks





The following identifies the information that is imported into the QuickBooks customer from an AyaNova client:

 

If the information is not listed here, than it does not get imported.

 

NOTE the following:

 

•to accommodate QuickBooks lack of company name information displaying in a QuickBooks invoice (as only shows what displays in Bill To address), QBI now imports the AyaNova company name into the first line of the QuickBooks company address field.
 

•to accommodate QuickBooks inability to use Ship To address in a QuickBooks invoice if there is no Bill To address, QBI will now import the AyaNova client's company name and address into the Bill To address as well as the Ship To address if there is only one address entered in the AyaNova client record.
 

•Set the Terms in QBI Preferences to what you want the default Terms to be for an imported AyaNova client into QuickBooks.
[image: ClientAyatoQB4_2]

 

•QuickBooks Contact: field is limited to 41 characters. If the AyaNova Contact: field has text that is more than 41 characters, it will be truncated in the QuickBooks Contact: field
 

 

The fields of data that are imported from an AyaNova Client object to a QuickBooks Customer object are:

 

 

 AyaNova client                        QuickBooks customer

 

1        Client Name                                Customer Name                                

2        Contact                                Contact

3        Business                                Phone                                        

4.        Fax                                        FAX

5.        Home                                        Alt. Ph.

6.        Email                                        Email

7.        Physical Address                        Ship To 1 Address

8.         Postal Address                        Bill To Address

9         Account Number                        Account No.

 

 

 

 

AyaNova client fields identified:

 

[image: ClientAyatoQB4_4]

 

[image: ClientAyatoQB4_5]

 

 

                         

QuickBooks customer fields identified:

 

[image: ClientAyatoQB4_1]

 

[image: ClientAyatoQB4_3]





AyaNova vendors data imported into QuickBooks





The following identifies the information that is imported into the QuickBooks vendor from an AyaNova vendor:

 

If the information is not listed here, than it does not get imported.

 

NOTE the following:

 

•As an AyaNova vendor is one of five set types, whereas QuickBooks you can create as many types as you wish - the QuickBooks vendor type is not set when the AyaNova vendor is imported.
 

•QuickBooks Contact: field is limited to 41 characters. If the AyaNova Contact: field has text that is more than 41 characters, it will be truncated in the QuickBooks Contact: field
 

 

The fields of data that are imported from an AyaNova Vendor object to a QuickBooks Vendor object are:

 

 AyaNova vendor                QuickBooks vendor

 

1        Vendor Name                Vendor Name                                

2.        Contact                        Contact

3.         Business                        Phone                                        

4.        Fax                                Fax                                        

5.        Home                                Alt. Ph.

6.        Email                                Email

7.         Postal Address                Address

8.        Account Number                Account No.

 

 

AyaNova vendor fields identified:

 

[image: VendorAyatoQB4_3]

 

 

QuickBooks vendor field identified:

 

[image: VendorAyatoQB4_1]

 

[image: VendorAyatoQB4_2]





AyaNova parts data imported into QuickBooks





The following identifies the information that is imported into the QuickBooks item from an AyaNova part:

 

If the information is not listed here, than it does not get imported.

 

NOTE the following:  

 

•You must select a QuickBooks COGS account, Income Account and a Asset Account when importing AyaNova parts into QuickBooks - see the example below.
•All AyaNova parts are imported into QuickBooks as type  "inventory part"
•The QuickBooks On Hand and Restock amount will be set to that of the total of all warehouses in AyaNova for that part
•Serial Numbers from AyaNova are not imported into QuickBooks
•Tax code in QuickBooks item is taken from QuickBooks defaults
 

 

1. Select to import/link Parts

[image: PartAyatoQB9]

 

2. Select one or more AyaNova parts as per How to import AyaNova data into QuickBooks

[image: PartAyatoQB1]

 

3. Drag and drop into the Drop here to import AyaNova item(s) which results in the confirmation question.

[image: PartAyatoQB2]

 

4. Now you need to select your QuickBooks COGS Account, your QuickBooks Income Account and your QuickBooks Asset Account so that these AyaNova parts you are importing into QuickBooks will be set with in QuickBooks. 

 [image: PartAyatoQB3]

 

5.  If for example, you have a bunch of parts that should have a specific Asset Account, than import only those at one time. And than import the rest that use a different Asset Account in the next batch so that you can select the specific Asset Account for those.

 

 

 

The fields of data that are imported from an AyaNova part object to a QuickBooks item object are:

 

 AyaNova part                        QuickBooks item

 

1.       Part Number                              Item Name/Number

2.       Part Display Format                    Description on Purchase

            (from Global Settings)                    / Description of Sales

3.       Cost                                          Cost

4.       Retail                                         Sales Price

5.       On Hand                                    On Hand

            (total from all warehouses)

6.       Restock                                     Reorder Point

            (total from all warehouses)

 

 

7.                                                        COGS Account  (set via QBI at time of import)

8.                                                        Income Account  (set via QBI at time of import)

9.                                                        Asset Account  (set via QBI at time of import)

 

 

[image: PartAyatoQB4]

 

 

[image: PartAyatoQB5]

 

[image: PartAyatoQB8]

 

[image: PartAyatoQB6]

 

[image: PartAyatoQB7]





AyaNova rates data imported into QuickBooks





The following identifies the information that is imported into the QuickBooks item from an AyaNova rate (whether service or travel):

 

Only fields identified below are imported.

 

NOTE the following:  

 

•You must select a QuickBooks Income Account when importing AyaNova rates into QuickBooks - see example below
•All AyaNova rates are imported into QuickBooks as type  "service"
•Tax code in QuickBooks item is taken from QuickBooks defaults
 

 

1. Select to import/link Service Rates -> Service rate (or select Travel rate if want to import travel rates into QuickBooks)

[image: RateAyatoQB1]

 

1. Select one or more AyaNova rates as per How to import AyaNova data into QuickBooks

[image: RateAyatoQB2]

 

2. Drag and drop into the Drop here to import AyaNova item(s) which results in the confirmation question.

[image: PartAyatoQB2]

 

3. Now you need to select your QuickBooks Income Account so that these AyaNova rates you are importing into QuickBooks will be set with in QuickBooks. 

 [image: RateAyatoQB3]

 

4.  If for example, you have a bunch of rates that should have a specific Asset Account, than import only those at one time. And than import the rest that use a different Asset Account in the next batch so that you can select the specific Asset Account for those.

 

 

 

The fields of data that are imported from an AyaNova rate object to a QuickBooks item object are:

 

 AyaNova rate                        QuickBooks item

 

1.        Rate Name                        Item Name/Number/ Description

2.        Retail Charge                        Rate

3.                                        Account  (set via QBI at time of import)

 

 

 

[image: RateAyatoQB4]

 

 

[image: RateAyatoQB5]

 

[image: RateAyatoQB6]





Update AyaNova's Mapped/Imported Parts





 

You can update linked parts Name, Number, Retail and Cost via the AyaNova Part's menu grid or the specific AyaNova Part's entry screen. 

 

You can update the AyaNova part with the edited QuickBooks part information or the other way, you can update the QuickBooks part with the edited AyaNova part information

 

NOTE: The AyaNova nor the QuickBooks part's On Hand nor its Restock amount are not updated. 

 

 

For example, you might edit in AyaNova the AyaNova part's Number or Name or Retail or Cost, and want that information updated to the linked QuickBooks part without having to manually edit the QuickBooks part.

 

1. To do this, select the part record you want updated in the Part's grid or open its entry screen. Note how you can tell it is selected in the Part's grid as in addition to the row being highlighted, also all fields are underlined.

[image: AyaParttoQBgrid1]

 

2. Select the PlugIns menu option in the Parts grid menu and select AyaNova QBI -> Refresh QuickBooks record

[image: AyaParttoQBgrid2]

 

[image: RefreshPart1]

 

3. Click on Yes to update the Quickbook's part information to that of the AyaNova part.

[image: RefreshPart2]

 

4. It will show Done when completed

[image: AyaClienttoQBentry4]

 

NOTE: QBI only obtains QuickBooks and AyaNova information when QBI first loads

If you enter new information into either QuickBooks or AyaNova with QBI running, you need to refresh the connections in 4 possible ways:

 

1. Select to Refresh QuickBooks connection from the main menu

[image: RefreshQBIconnection]

2. From within QBI, select Refresh QuickBooks connection

[image: RefreshQBconnection]

3. If not seeing AyaNova service workorders that are ready for invoicing, from QBI's Invoices menu select Refresh invoices

[image: RefreshInvoices]

4. Exit out of QBI, exit out of AyaNova. Log back into AyaNova and start QBI again.

 

 

 

 

 

 





Update QuickBooks Mapped/Imported Parts





 

You can update linked parts Name, Number, Retail and Cost via the AyaNova Part's menu grid or the specific AyaNova Part's entry screen. 

 

You can update the AyaNova part with the edited QuickBooks part information or the other way, you can update the QuickBooks part with the edited AyaNova part information

 

NOTE: The part's On Hand nor its Restock amount are not updated. 

 

 

For example is that you might edit in QuickBooks the QuickBooks part, and want that information updated to the linked AyaNova part without having to manually edit the AyaNova part.

 

1. To do this, select the part record you want updated from the Part's grid or open its entry screen. Note how you can tell it is selected in the Part's grid as in addition to the row being highlighted, also all fields are underlined.

[image: AyaParttoQBgrid1]

 

2. Select the PlugIns menu option in the Parts grid menu and select AyaNova QBI -> Refresh AyaNova record

[image: AyaParttoQBgrid2]

 

[image: RefreshPart3]

 

3. Click on Yes to update the AyaNova's part information to that of the QuickBooks part.

[image: RefreshPart4]

 

4. It will show Done when completed

[image: AyaClienttoQBentry4]

NOTE: QBI only obtains QuickBooks and AyaNova information when QBI first loads

If you enter new information into either QuickBooks or AyaNova with QBI running, you need to refresh the connections in 4 possible ways:

 

1. Select to Refresh QuickBooks connection from the main menu

[image: RefreshQBIconnection]

2. From within QBI, select Refresh QuickBooks connection

[image: RefreshQBconnection]

3. If not seeing AyaNova service workorders that are ready for invoicing, from QBI's Invoices menu select Refresh invoices

[image: RefreshInvoices]

4. Exit out of QBI, exit out of AyaNova. Log back into AyaNova and start QBI again.

 

 

 





Update only AyaNova part's cost and retail price





You can update just the AyaNova parts Cost and Retail with the cost and retail from the QuickBooks linked part via the main QBI program through the Map/Import menu option.

 

NOTE the following:

 

•This feature updates only the AyaNova's Part Retail Price and Cost fields 
•This feature does not update other fields of the AyaNova Part 
•This feature does not change a work order's Part price or cost 
•QBI can only update the price and cost of what the QuickBooks item price and cost was at the time QBI was first opened. If you have edited the QuickBooks item price/cost since opening QBI, you need to refresh the QB connection
[image: RefreshQBconnection]

 

 

For example, let's say that you edited the QuickBooks part pricing for two parts in QuickBooks. When you run QBI in AyaNova, do the following to update the AyaNova part pricing:

 

1. In Map / Import select Parts

[image: partsynch1]

 

2. Select the menu option Update AyaNova Prices

[image: partsynch2]

 

3. QBI will ask you to confirm that you want to change all linked AyaNova parts to current QuickBooks item price and cost

[image: partsynch3]

 

4. QBI will compare each linked AyaNova Part's price and cost with the linked QuickBooks item price and cost at the time when QBI was opened. If the linked QuickBooks item price and/or cost is different, QBI will change the AyaNova part's price and/or cost.

 

 

5. Once the update is completed, QBI will identify how many AyaNova part's were updated, and when you click on OK, will close QBI  so that you can re-open it so are starting with the updated data.

[image: partsynch4]

 

 

 

NOTE: QBI only obtains QuickBooks and AyaNova information when QBI first loads

If you enter new information into either QuickBooks or AyaNova with QBI running, you need to refresh the connections in 4 possible ways:

 

1. Select to Refresh QuickBooks connection from the main menu

[image: RefreshQBIconnection]

2. From within QBI, select Refresh QuickBooks connection

[image: RefreshQBconnection]

3. If not seeing AyaNova service workorders that are ready for invoicing, from QBI's Invoices menu select Refresh invoices

[image: RefreshInvoices]

4. Exit out of QBI, exit out of AyaNova. Log back into AyaNova and start QBI again.

 

 

 

 





Updating AyaNova Mapped/Imported Clients





You can update linked parts Name, Number, Retail and Cost via the Client's menu grid or the specific Client's entry screen.

 

NOTE: You can update the AyaNova client with the edited QuickBooks client information, or the other way, you can update the QuickBooks client with the edited AyaNova client information

 

For example, you might edit in AyaNova the AyaNova client's address and phone number, and want that information updated to the linked QuickBooks client without having to manually edit the QuickBooks client.

 

1. To do this from the client entry screen select AyaNova QBI -> Refresh QuickBooks record

[image: AyaClienttoQBentry1]

 

[image: RefreshClient4]

 

3. Click on Yes to update the Quickbook's client information to that of the AyaNova client.

[image: RefreshClient3]

 

4. It will show Done when completed

[image: AyaClienttoQBentry4]

 

NOTE: QBI only obtains QuickBooks and AyaNova information when QBI first loads

If you enter new information into either QuickBooks or AyaNova with QBI running, you need to refresh the connections in 4 possible ways:

 

1. Select to Refresh QuickBooks connection from the main menu

[image: RefreshQBIconnection]

2. From within QBI, select Refresh QuickBooks connection

[image: RefreshQBconnection]

3. If not seeing AyaNova service workorders that are ready for invoicing, from QBI's Invoices menu select Refresh invoices

[image: RefreshInvoices]

4. Exit out of QBI, exit out of AyaNova. Log back into AyaNova and start QBI again.

 

 

 

 





Update QuickBooks Mapped/Imported Clients





 

For example is that you might edit in QuickBooks the QuickBooks client's address and phone, and want that information updated to the linked AyaNova client without having to manually edit the AyaNova client.

 

1. To do this from the client entry screen select AyaNova QBI -> Refresh AyaNova record

[image: AyaClienttoQBentry1]

 

[image: RefreshClient1]

 

3. Click on Yes to update the AyaNova's client information to that of the QuickBooks client.

[image: RefreshClient2]

 

4. It will show Done when completed

[image: AyaClienttoQBentry4]

NOTE: QBI only obtains QuickBooks and AyaNova information when QBI first loads

If you enter new information into either QuickBooks or AyaNova with QBI running, you need to refresh the connections in 4 possible ways:

 

1. Select to Refresh QuickBooks connection from the main menu

[image: RefreshQBIconnection]

2. From within QBI, select Refresh QuickBooks connection

[image: RefreshQBconnection]

3. If not seeing AyaNova service workorders that are ready for invoicing, from QBI's Invoices menu select Refresh invoices

[image: RefreshInvoices]

4. Exit out of QBI, exit out of AyaNova. Log back into AyaNova and start QBI again.

 

 

 





What is Descriptive Text?





 

When you use QBI to invoice out billable items from an AyaNova workorder into a QuickBooks invoice, you could print a workorder report from AyaNova and physically provide the report along with the QuickBooks invoice.

 

OR you could specify Descriptive Text to show on the QuickBooks invoice - which is text from the AyaNova workorder that was billed out

 

 

Descriptive Text is set via the Tools -> Invoice descriptive text template menu option from the main QBI screen

[image: DescriptiveTextMenu]

 

You can set as much or as little descriptive text about the service workorder(s) to display on the QuickBooks invoice. 

 

You can use the pre-set defaults, and/or edit directly what you wish to display, and/or have no additional text display

 

For example, the screenshot below shows that this invoice has the additional descriptive text from the workorder identifying the following:

 

•what AyaNova workorder number the invoice is for
•test from the AyaNova workorder item summary
•and details about the labor service provided
[image: QBIinvoiceDescriptive]

 

Because the Invoice descriptive text template had the following settings:

[image: QBIInvoiceDetailedDecriptivetext]

 

 





Editing the Descriptive Text Template





 

1. From the main QBI screen, select the Tools -> Invoice descriptive text template menu option

[image: DescriptiveTextMenu]

 

 

2. You can use either the default brief format or default detailed format, or edit the format manually:

 

 

A. Set to default brief format

 

To display just the text "Charges for the workorder:" and the workorder number, than just select the menu option Set to default brief format.  This is useful so that  the client can reference the included Detailed Completed Service Workorder report you have printed out to include with the QuickBooks invoice - especially if you have a lot of detail in the service workorder which the QuickBooks invoice may span many many pages to display.

 

[image: DefaultSummaryDescriptiveText]

 

 

B. Set to default detailed format

 

Or if you do want the QuickBooks invoice to display text about everything billable from the service workorder, than select the menu option Set to default detailed format.  Do note QuickBooks invoices are very limited in the amount of text that can display, so your invoice may span multiple pages. It is up to you to test what descriptive text meets your needs.

 

[image: DefaultDetailedDecriptivetext]

 

 

 

C. Editing the text and service workorder data to display:

 

You can edit specifically what text you want to display and what data from the AyaNova service workorder by placing your cursor with the text area, entering any text, and than select the menu option Insert xxxxx field (where xxxxx will be the section of the AyaNova service workorder it corresponds to)

 

Do not manually type in data field tokens for an incorrect section - for example, do not enter ~WO#~ in the Unit: text area field. That is why the menu option at the top is for selection for that specific text area.

 

For example, let's say if a specific unit in a workorder item was selected for service, you want the following to display on the QuickBooks invoice:

 

Serial Number of serviced equipment: serial number

 

Click in the Unit: text area and you will note that the menu changes to Insert unit field:

Type in the text (and/or replace the existing text and data fields) you want to display such as Serial Number of serviced equipment:

Than select the menu option Insert unit field: to drop down the list of selectable data fields from the Unit section of the service workorder and select  ~UNIT_SN~

Note how the ~UNIT_SN~ is inserted into that text area.

 

[image: descriptivetext1]

 

 

Always be aware that the QuickBooks invoice is very limited in the amount of descriptive text that can display - so if you do use the Default Detailed Format, the invoice will more than likely span more than one page.

 

 

 

 





Service workorder data that can be entered as descriptive text





We will identify here the service workorder data fields that are selectable to be included via descriptive text in a QuickBooks invoice via QBI

 

Where ever you see text that is preceded and followed by a ~ symbol in each of the text areas - these are referred to as tokens

 

Tokens in the descriptive text template denotes to QBI to obtain the data for that token from the service workorder if applicable.

 

For example,  ~W0#~ will be replaced by the service workorder number.

 

Each of the text areas corresponds to a section of a AyaNova service workorder.

 

If the service workorder data field is not listed here, than it can not be entered as descriptive text on a QuickBooks invoice via QBI - it is suggested to enter it manually in the QuickBooks invoice itself, or instead print out a Detailed Completed Workorder report to accompany the invoice so that all details are provided to the client along with the invoice.

 

From the service workorder header fields text area section:

 

Screenshot below shows the correspondence of the service workorder header fields with the selection in the descriptive text template.

 

•Select Client contact to insert the ~CONTACT~ token to represent the data from the billable service workorder's Contact field  into the workorder header fields text area
•Select Client reference number to insert ~CREF#~
•Select Internal reference number to insert ~OURREF#~
•Select Project name to insert ~PROJ~
•Select Workorder client name to insert ~CLIENT~
•Select Workorder number to insert ~WO#~
•Select Workorder service date to insert ~SERVDATE~
•Select Workorder status name to insert ~STAT~
•Select Workorder summary to insert ~DESC~
 

  [image: insertheader]

 

From the workorder items fields text area section:

 

Screenshot below shows the correspondence of the service workorder item fields with the selection in the descriptive text template.

 

•Select Workorder item summary to insert the ~ITEM_SUMMARY~ token to represent the data from the billable service workorder item's Item Summary field into the workorder items text area
•Select Workorder item service notes to insert ~ITEM_SERVICE_NOTES~
•Select Workorder item type to insert ~ITEM_TYPE~
•Select Workorder item request date to insert ~ITEM_REQUEST_DATE~
•Select Workorder item status to insert ~ITEM_STATUS~
 

 

 

[image: insertitems]

 

 

From the Unit text area section:

 

•Select AyaNova unit display format to insert the ~AYAFORMAT~ token to represent the Global Settings format of the selected unit in that billable service workorder into the Unit text area
•Select Unit serial number to insert ~UNIT_SN~
•Select Unit meter reading to insert ~UNIT_METER~  (note - only a meter reading that was entered via the meter reading steps as outlined in the AyaNova Help file How To enter a unit meter reading via a Service Workorder)
•Select Manufacturer to insert ~UNIT_MAKE~
•Select Unit model name to insert ~UNIT_MODEL_NAME~
•Select Unit model number to insert ~UNIT_MODEL_DESC_NUMBER~
 

[image: insetunit]

 

 

From the Labor text area section:

 

Screenshot below shows the correspondence of the service workorder Labor with the selection in the descriptive text template.

 

•Select Start date and time to insert the ~SERVICE_START~ token to represent the Labor record's Start Date & Time into the Service text area
•Select Stop date and time to insert ~SERVICE_STOP~
•Select Quantity to insert ~SERVICE_QUANTITY~
•Select Rate name to insert ~RATE_NAME~
•Select Technician to insert ~SERVICE_TECH~ (this is the schedulable user that is selected in the Labor record)
•Select Details to insert ~DETAILS~
•Select No charge quantity to insert ~NO_CHARGE_QUANTITY~
 

[image: insertservice]

 

 

 

From the Travel text area section:

 

Screenshot below shows the correspondence of the service workorder Travel with the selection in the descriptive text template.

 

•Select Start date and time to insert the token ~TRAVEL_START~ to represent the Travel's record Start Date & Time of the invoiced workorder item into the Travel text area
•Select Stop data and time to insert ~TRAVEL_STOP~
•Select Quantity to insert ~TRAVEL_QUANTITY~
•Select Travel rate name to insert ~TRAVEL_RATE_NAME~
•Select Technician to insert ~TRAVEL_TECH~
•Select Details to insert ~TRAVEL_DETAILS~
•Select Distance to insert ~TRAVEL_DISTANCE~
•Select No charge quantity to insert ~TRAVEL_NO_CHARGE_QUANTITY~
 

 

[image: inserttravel]

 

From the Outside Service text area section:

 

Screenshot below shows the correspondence of the service workorder Outside Service with the selection in the descriptive text template.

 

•Select Repair price to insert the token ~REPAIR_PRICE~ to represent the Repair Price field from the Outside Service section of the service workorder item  into the Outside Service text area
•Select Shipping charges to insert ~SHIP_CHARGE~
•Select Date sent to insert ~SENT~
•Select Date returned to insert ~RETURNED~
•Select Notes to insert ~NOTES~
 

[image: insertoutsideservice]

 

 

From the Expenses text area section:

 

Screenshot below shows the correspondence of the service workorder Expenses with the selection in the descriptive text template.

 

•Select Charges to insert the token ~CHARGES~ to represent the Charge Amount field from the Expenses record for the invoiced workorder item into the Misc.Expenses text area
•Select Summary to insert ~SUMMARY~
•Select Description to insert ~DESCRIPTION~
•Select Technician to insert ~TECH~
 

[image: insertexpenses]

 

From the Loans text area section:

 

Screenshot below shows the correspondence of the service workorder Loans with the selection in the descriptive text template.

 

•Select Item loaned to insert the token ~ITEM~ to represent the Loan Item from the Loans section of the service workorder item that is invoiced into the Loans text area
•Select Charges to insert ~CHARGE~
•Select Loaned Date to insert ~LOANED~
•Select Returned Date to insert ~LOAN_RETURNED~
•Select Notes to insert ~LOAN_NOTES~
 

 

[image: insertloans]

 

 

 

 

 





How to invoice AyaNova workorders into QuickBooks invoices





 

Now that you have done the following...

 

•set your QBI Preferences, 
•have edited your Descriptive Text so that text from the AyaNova workorder shows on the QuickBooks invoice if desired
•have linked existing data between AyaNova and QuickBooks
•and/or imported QuickBooks data (customers, vendors, items) into AyaNova
•and/or imported AyaNova data (clients, vendors, rates, parts) into QuickBooks
 

... you are ready to invoice AyaNova workorders into QuickBooks invoices.

 

 

To invoice AyaNova workorders into QuickBooks invoices, all you have to do is:

 

1.Make sure your QuickBooks program is running on your computer with your QuickBooks company data file open
 

2.Start the QBI program from within the AyaNova program from the Plug-Ins menu if not already running
[image: QBIRun1]

 

 

QBI will read the QuickBooks data in

[image: QBIsetup4]

 

Will confirm with you the QuickBooks company data file

 

 

Then select from the PlugIns again

[image: QBIRun1]

 

And click on QBI Main to bring up QBI Main screen

[image: QBIMain1]

 

 

3.If it states no invoiceable work orders found in AyaNova, but you do have workorders that need to be invoiced, then you need to check as per the message and as per the section No service workorders ready for invoicing
[image: Noinvoiceableworkorders]

 

4.If it displays client names and workorder numbers with a red X [image: notready] beside them, that tells you that you have either clients not linked between AyaNova and QuickBooks, or parts not linked, or parts with different prices etc.  Refer to the section Fix unlinked objects or parts with differing price for details
[image: invoiceableworkorders1]

 

5.If you want a single AyaNova workorder to be invoiced out in a single QuickBooks invoice
 

6.If you want multiple AyaNova workorders for the same client to be invoiced out to a single QuickBooks invoice
 

7.If you have a number of service workorders all for different clients ready for invoicing, you can have QBI have QuickBooks invoice all workorders at one time into respective invoices
 

8.Refer to What happens when QBI invoices?
 

 





No service workorders ready for invoicing





If the main QBI screen displays as the screen shot below:

 

[image: Noinvoiceableworkorders]

 

As the message states - there are no service workorders that meet the four setting requirements to be able to have QBI ready them for invoicing into QuickBooks.

 

If you do have service workorders that you know are ready for invoicing but the above message displays, do the following 6 steps:

 

 

1. Confirm that the workorder's Service Completed field is check-marked

2. The Closed field is not check-marked

3. The Invoice #: field is empty

4. The Workorder Status is set to that selected in Preferences for Billable Workorder Status <screen shot below  of workorder status may not reflect what you have actually selected in your preferences>

[image: InvoiceRequirements1]

 

5. If you made any changes to the workorder, be sure to Save & Exit.

6. In QBI, select the menu option Invoices -> Refresh invoices so that QBI checks to see if there now are workorders that are ready for invoicing

[image: RefreshInvoices]

 

NOTE: QBI only obtains QuickBooks and AyaNova information when QBI first loads

If you enter new information into either QuickBooks or AyaNova with QBI running, you need to refresh the connections in 4 possible ways:

 

1. Select to Refresh QuickBooks connection from the main menu

[image: RefreshQBIconnection]

2. From within QBI, select Refresh QuickBooks connection

[image: RefreshQBconnection]

3. If not seeing AyaNova service workorders that are ready for invoicing, from QBI's Invoices menu select Refresh invoices

[image: RefreshInvoices]

4. Exit out of QBI, exit out of AyaNova. Log back into AyaNova and start QBI again.

 

 

 





Fix unlinked objects or parts with differing price





When service workorders are deemed as ready for invoicing, at that time QBI will bring to your attention if the following information in the AyaNova object is different from that in the QuickBooks object:

 

•AyaNova client, part or rate in the billable service workorder is not linked to an existing QuickBooks customer or item.
 

•AyaNova part retail charge in a service workorder that is ready for invoicing does not match the retail charge of the QuickBooks Item.
 

 

If QBI determines that there are unlinked objects or that price information is not the same between the QuickBooks item and the AyaNova item, QBI will display either the unlinked client or the service workorder number with an [image: notready] image next to it to indicate it needs fixing before continuing.

 

If no issues, QBI displays an [image: ready] image next to it to indicate there are no problems - it is presently linked and/or does not have any price differences

 

[image: invoiceableworkorders1]

 

In the screenshot above:

 

•The client ABC Accounting has an [image: notready] image next to it because it is not presently linked to a QuickBooks customer
 

•The client Blundell, Amanda has an  [image: ready] image next to it as it is presently linked to a QuickBooks customer.
 

•The service workorder 70 has an  [image: notready] image next to it as it is not ready to be invoiced as it has a problem (either unlinked items or price differences)
 

•The service workorder 71 has an  [image: ready] image next to it as it is ready to be invoiced - parts billable in this service workorder are linked and do not have any price differences
 

•The service workorder 70 has an  [image: notready] image next to it as it is not ready to be invoiced as it has a problem (either unlinked items or price differences)
 

 

 

To fix issues, select the menu option Invoices -> Fix Problems

 

[image: FixProblems]

 

•This will display a list of all issues affecting all billable service workorders as shown in the screen shows below regarding the problems that you can fix via QBI.
 

 

 

Problem is NotLinkedToQB

 

The AyaNova client, part or rate in the billable service workorder is not linked to a QuickBooks customer or item, and has to be fixed before continuing.

 

If object is an AyaNova client:

 

[image: fixproblemsclient]

 

[image: fixproblemsclient2]

 

Note that QBI only obtains QuickBooks and AyaNova information when QBI first loads - so if you enter new information into either QuickBooks or AyaNova with QBI running - QBI will not be aware of it. You need to close QBI and open it again.

 

 

If object is an AyaNova part or rate:

 

[image: fixpartlink1]

 

Note when fixing a Part or a Rate, you can not import the AyaNova part or rate into QuickBooks - your option is to link it to an existing QuickBooks item only. 

 

NOTE: If instead you want to import the AyaNova part or rate into QuickBooks, you will need to import these into QuickBooks using either the Map and Import menu option, or import the part via the AyaNova part grid or part entry screen.

 

Drop down the list of available QuickBooks items to link this AyaNova object to.

 

If there is not an equivalent QuickBooks item, you will need to manually enter it into QuickBooks, restart QBI and than link to it.

 

Note that QBI only obtains QuickBooks and AyaNova information when QBI first loads - so if you enter new information into either QuickBooks or AyaNova with QBI running - QBI will not be aware of it

 

[image: ficpartlink2]

 

 

 

 

Problem is PriceDifference

 

Before invoicing, if there is a price difference, on a part by part basis you will have the choice of:

 

1.Use the workorder price as it is; even though it's different
•Leaving the retail price as is in AyaNova service workorder, and invoicing out at that AyaNova retail price in the QuickBooks invoice.
• **if selected, but you close QBI before invoicing, you will need to select this again when you open QBI again as QBI will note again that there is a difference.
2.Set the workorder item's price to the QuickBooks price
•Updating the retail price and cost in the AyaNova service workorder to that of QuickBooks part, and invoicing out at the QuickBooks retail price.
•**if selected, this affects the workorder item part price immediately, even if you close QBI before invoicing
3.Set the AyaNova object's default price to be the QuickBooks price from now on
•Updating the retail price in the AyaNova service workorder to that of QuickBooks part , and updates the AyaNova part retail price in the AyaNova object to that of the QuickBooks object, and invoicing out at the QuickBooks retail price. 
•**if selected, this affects the AyaNova part object price, as well as the part price in the service workorder immediately, even if you close QBI before invoicing
4.Set the QuickBooks object's default price to be the AyaNova price from now on
•Leaving the retail price as is in AyaNova service workorder, update the retail price in the QuickBooks object to that of the AyaNova part retail price, and invoicing out at that AyaNova retail price in the QuickBooks invoice 
•**if selected, this affects the QuickBooks part price immediately even if you close QBI before invoicing
•Do note that only QuickBooks items that are of Inventory type can have their default price changed
 

 

Note that the first two just change the workorder price and do not affect the AyaNova item or the QuickBooks item for other use - whereas the last two actually change the price of the item as well as the workorder price. 

 

 

 

[image: fixprice1]

 

[image: fixprice2]

 

 

 

See also:

Update Mapped/Imported Parts

Updating Mapped/Imported Clients





Taxes





QBI does not and can not use the tax code selected in your AyaNova service workorder billable items.

 

QBI does not import or export tax codes between AyaNova and QuickBooks

 

An invoice in QuickBooks created by QBI for an AyaNova service workorder billable items uses the tax codes set up for the QuickBooks client itself (i.e. client) and doesn't refer in any way to the tax code selected in the AyaNova service workorder.

 

If an invoice in QuickBooks has an incorrect tax code or codes, check what is set for that QuickBooks client.

 

 





Parts invoicing





 

A part in an AyaNova workorder that is serialized will have the AyaNova part's serial number display under the invoiced part in the QuickBooks invoice.

 

The Description field from a part in an AyaNova workorder will now also display under the invoiced part in a QuickBooks invoice unless it is empty or contains the exact same serial number of that in the Serial Number field in the workorder's part.

 

From the AyaNova workorder

[image: Partsinvoicing1]

 

 

From the QuickBooks invoice

[image: Partsinvoicing2]





Discount % set in Parts is applied via a QuickBooks invoice





QBI does apply discounts set in the AyaNova workorder to the QuickBooks invoice

 

If you have applied a discount on a part record in an AyaNova workorder, that net price which is the AyaNova part price X the discount will be identified by QBI

 

If the AyaNova net price (part price X discount) is different than that of the QuickBooks item price, QBI will identify that there is a price problem that needs to be addressed and will identify it as due to a discount (i.e Price XX.XX discounted XX% on workorder)

 

See also:

Fix unlinked objects or parts with differing price

 

 

 





Banked service invoiced out at 0$





QBI will identify if a labor item in an AyaNova workorder has been banked via Banked Service, and will always invoice it at 0$ amount.

 

Banked service in AyaNova is pre-payment for services.

Refer to your AyaNova Help documentation for more on Banked Service.

 

As your client has pre-paid already for service, and you have in AyaNova itself banked the service charges against their pre-paid amount, the client will not be re-billed for that service.

 





Travel or Service Rate retail charges





AyaNova QBI will take by default the AyaNova Service Rate's or Travel Rates Retail Charge price no matter what is the Rate set for the linked item in QuickBooks.

 

This is because a large majority of users will have multiple AyaNova rates all at different retail prices linked to one QuickBooks item that is used for billing out service. 

 

You are not notified if there is a discrepancy between the AyaNova rate's Retail Charge and the  linked QuickBooks item's Rate.

 

In the two screen shots below, the QuickBooks item SERV001 is linked to multiple AyaNova service rates. This way QuickBooks has only one rate that is used for bill out of service, and AyaNova maintains the different rates for each service.

 

[image: servicerates1]

 

[image: servicerates2]

 

The QuickBooks item SERV001 shows a rate of $0.00

 

[image: servicerates3]

 

With this QBI feature, no matter the rate selected in the AyaNova service workorder, the rate is always billed out at the rate's Retail Charge

 

It is always recommended to create a specific rate in AyaNova for every Retail Charge.





Misc Expenses charges





AyaNova QBI will use the QuickBooks item selected in Preferences as the item to use when billing Expenses.

 

[image: 10miscQBaccount]

 

AyaNova QBI will take the AyaNova service workorder Expenses Charge Amount price no matter what is the Rate set for the linked item in QuickBooks.

 

You are not notified if there is a discrepancy between the AyaNova service workorder Expenses Charge Amount price and the linked QuickBooks item's Rate.

 

Also note that QBI takes the Charge Amount only, as QBI does not transfer the taxes identified on service workorders.

 

The Charge Amount is transferred to the QuickBooks invoice, and the default tax as set in QuickBooks is applied. Therefore ensure that the tax setting in QuickBooks for the Expenses is set correctly - or edit the invoice after QBI creates it - or for future charges, edit the QuickBooks item tax setting default.

 

[image: invoiceexpenses1]





Outside Service charges





AyaNova QBI will use the QuickBooks item selected in Preferences as the item to use when billing Outside Service charges.

 

[image: 8outsideservicechargeQBaccount]

 

AyaNova QBI will take by default the AyaNova service workorder Outside Service Repair Price + Shipping Price combined no matter what is the Rate set for the linked item in QuickBooks.

 

You are not notified if there is a discrepancy between the Outside Service combined Repair Price + Shipping Price amount and the linked QuickBooks item's Rate.

 

 

[image: invoiceoutsideservice1]

 

[image: invoiceoutsideservice2]

 

 





Invoicing indivdual AyaNova service workorders via QBI into QuickBooks





If you have a number of service workorders ready for invoicing that are all for the same client, you can have QBI have QuickBooks invoice each service workorder individually by selecting the specific workorder to be invoiced.

 

 

1. QBI lists by the client. In the screenshot below we have service workorders ready to be invoiced for three different clients.

 

[image: readytoinvoice1]

 

2. You can expand to see what workorders are for each client by select the [image: plus] beside each client name <note how the [image: plus] image turns to a [image: minus] image when you select it to show it is expanded>

 

[image: readytoinvoice2]

 

 

3. To invoice a specific AyaNova service workorder into one QuickBooks invoice

 

a. Select the row object indicator (the square to the left of the workorder row if multiple workorders are listed - or if the client has only one workorder, you can select the row object indicator to the left of the client name)

 

[image: readytoinvoice3]

 

b. Now either right-click and select Invoice selected items to QuickBooks... One workorder per invoice

 

[image: readytoinvoice4]

c. Or with that object indicator selected, select the menu Invoices -> Invoice selected items to QuickBooks... One workorder per invoice

 

[image: readytoinvoice5]

 

4. Once a service workorder has been invoiced, it no longer displays in the list and you can continue invoicing individually or multiple service workorders for the same client.

 

[image: readytoinvoice6]

 

 

Do be aware because of the QuickBooks invoice space limitations, your descriptive text may cause the invoice to span many pages. 





Invoicing multiple service workorders for one client into one QuickBooks invoice





If you have a number of service workorders ready for invoicing that are all for the same client, you can have QBI have QuickBooks invoice all those into one invoice to the same linked QuickBooks client.

 

 

1. QBI lists by the client. In the screenshot below we have service workorders ready to be invoiced for three different clients.

 

[image: readytoinvoice1]

 

2. You can expand to see what workorders are for each client by select the [image: plus] beside each client name <note how the [image: plus] image turns to a [image: minus] image when you select it to show it is expanded>

[image: readytoinvoice2]

 

 

 

3. To invoice all AyaNova service workorders for one client into one QuickBooks invoice

 

a. Select the object indicator for the client (the square to the left of the client name)

 

[image: readymult2]

 

b. Now either right-click and select -> Invoice selected items to QuickBooks... Multiple workorders per invoice

 

[image: readymult3]

 

c. Or with that that client object indicator selected, select the menu Invoices -> Invoice selected items to QuickBooks... Multiple workorders per invoice

 

[image: readymult4]

 

 

4. Once all service workorders for a client have been invoiced, the client no longer displays in the list as there are no further workorders for that client to invoice

 

[image: readymult5]

 

 

Do be aware because of the QuickBooks invoice space limitations, your descriptive text may cause the invoice to span many pages. 





Invoicing all ready service workorders





If you have a number of service workorders all for different clients ready for invoicing,  you can have QBI have QuickBooks invoice all workorders at one time into respective invoices.

 

 

 

1. In the screenshot below we have service workorders ready to be invoiced for three different clients.

 

[image: readytoinvoice1]

 

2. If we expand each of the clients, we can see that two of the clients have multiple service workorders to be billed out

 

[image: readyall1]

 

 

3. We can either A. invoice all workorders for all clients, with each client getting one invoice even if multiple workorders  OR B. invoice all workorders for all clients, each workorder to its own invoice

 

 

A. invoice all workorders for all clients, with each client getting one invoice even if multiple workorders

 

•hold the CTRL key from our keyboard and select the object indicator for each of the three clients
 

[image: readyall2]

 

 

•Now we select the menu Invoices -> Invoice selected items to QuickBooks...Multiple workorders per invoice
 

[image: readyall3]

 

•There will be three invoices created in QuickBooks
 

One invoice for client ABC Accounting that is for the workorders #43, 50, 54, 70

One invoice for BGF Accounting that is for the workorder #75

One invoice for Merville General that is for workorder #71 and #110

 

 

 

B. invoice all workorders for all clients, each workorder to its own invoice

 

•hold the CTRL key from our keyboard and select the object indicator for each of the three clients
 

[image: readyall2]

 

 

•Now we select the menu Invoices -> Invoice selected items to QuickBooks...One workorder per invoice
 

[image: readyall4]

 

•There will be seven invoices created in QuickBooks - one for each workorder listed.
 

 





What happens when QBI invoices?





 

1. QBI display screen:

 

The listed clients and their billable workorders will no longer display in the list as they have now been invoiced

[image: Noinvoiceableworkorders]

 

2. In the QuickBooks invoice:

 

Workorder header descriptive text (if applicable) is placed before any charges

Billable items for that service workorder are than listed

•Parts are listed first, than Service, than Travel, than Expenses, Loans and Outside Service charges.
•If multiple workorder items with the same parts or labor etc, all billable items are billed out individually.
•For example, if billed out the same labor rate in multiple workorder items in the same workorder, each billable amount per labor item is listed separately
Additional Descriptive Text set in QBI is than listed for that service workorder (if set to use Descriptive Text)

If multiple workorders billed on the same invoice, than the next workorder billable information is listed starting with workorder header descriptive text if applicable and so on as above

 

 

3. In the AyaNova service workorder:

 

AyaNova service workorder(s) have the following fields updated

•Workorder Status in the workorder header area is updated to the status set in Preferences for Post billing workorder status 
•The Invoice #: field is filled with the QuickBooks invoice number
If the Preference "Close Workorder After Invoicing" has been check-marked, the AyaNova service workorder is set to the Closed state and can no longer be edited by any user
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